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1  Change history

Product version Document Changes/comments

• FieldCare:
2.13.xx

• DeviceCare:
1.05.xx

KA01303S/04
/A2/04.18

New product version
DeviceCare: new product version

• FieldCare:
2.14.xx

• DeviceCare:
1.06.xx

KA01303S/04
/A2/05.19

New product version

• FieldCare:
2.14.xx

• DeviceCare:
1.07.xx

KA01303S/04
/A2/06.20

New setups (new components)
DeviceCare: new product version

• FieldCare:
2.15.xx

• DeviceCare:
1.07.xx

KA01303S/04
/A2/07.20

New FieldCare product version

• Software license management
• USB stick replaces DVD

• FieldCare:
2.16.xx

• DeviceCare:
1.07.xx

KA01303S/04
/EN/08.22-00

Section 4.3: Note on software update service

• FieldCare:
2.17.xx

• DeviceCare:
1.07.xx

KA01303S/04
/EN/09.22-00

New FieldCare product version

• FDI Package support
• Security update

• FieldCare:
2.18.xx

• DeviceCare:
1.07.xx

KA01303S/04
/EN/10.23-00

New FieldCare product version

• Windows 11 support
• Microsoft SQL Server 2022 Express
• Update to FDI Package support, Endress+Hauser

and third-party manufacturers
• PROFINET CommDTM updated
• CDI CommDTM updated
• Flow Verification DTM updated
• Security update of components
• Security manual SD03193S
• Catalog update, B&R scanning and IO-Link improved
• W@M functionality removed as the W@M portal

was shut down on 31.12.2023
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Product version Document Changes/comments

• FieldCare:
2.19.xx

• DeviceCare:
1.08.xx

KA01303S/04
/EN/11.24-00

• FXA291 communication driver updated V2.12.36.4
• Softing PROFIdtm updated V2.24.00
• Flow Verification DTM updated V2.02.00
• PROFINET CommDTM updated V1.01.00
• Bug fixes

• FieldCare:
2.20.xx

• DeviceCare:
1.08.xx

KA01303S/04
/EN/12.26-00

• New PROFINET CommDTM supports Siemens CFU-
PA

• New driver for CDI USB (supports Windows 11)
• New driver for TXU10V2 (supports Windows 11)
• Security improvements (CodeMeter V8.40a)
• Automatic DTM and driver updates can be enabled

or disabled
• .NET 4.8 is used by setup and installed if missing
• Bug fixes

2  About this document

2.1  Document function
The Brief Operating Instructions contain all the essential information from
incoming acceptance to initial commissioning.

These instructions contain all the information needed to install and update the
software.

2.2  Symbols used

Symbol Meaning

Open the start page of the Installation Manager.

Open the language setting.

Additional information about the software.

Close the application.

Jump back to the last page opened.
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Symbol Meaning

Information about FieldCare, modem, Fieldgate, Field Xpert.

Open the keyboard.

Full screen.

Exit full screen.

3  Product description

3.1  Software function
The Installation Manager guides the user through the installation of all the
FieldCare components which are delivered within the FieldCare package (frame
application, driver, CommDTM-files, DeviceDTM-files, tools). Administrator rights
are needed to perform the installation.

3.2  Software license management (SLM)

3.2.1  FieldCare SFE500 licensing model
FieldCare is delivered with a free, time-limited trial license. The licensing
agreement (EULA) applies for the use of the license. If FieldCare is to be used on a
permanent basis, FieldCare must be purchased and the license activated with the
software ID provided.

The FieldCare licensing model consists of a basic module called "Plant Asset
Management" (PAM) and an extension called "Condition Monitoring". A license
comprises a combination of the PAM module plus any extensions.

To be able to use the current FieldCare version, the software must be
activated with the software ID. The license key of the previous FieldCare
versions (< 2.15.00) can no longer be used for the current FieldCare version.
For more information, visit www.endress.com/sfe500 or contact your local
Endress+Hauser sales partner.



Endress+Hauser 5

Software license management offers the following functions:
• Use of the software in trial mode for 60 days
• Permanent activation of the software (with or without Internet connectivity)
• License renewal
• Return of the license

Activating the software permanently
Prerequisites:
• The software is installed on the computer
• The licensing agreement (EULA) has been accepted

Activating the software permanently with Internet connectivity
Prerequisites:
The software ID is available

The software ID is located on the label of the USB box containing the
FieldCare USB stick or in the e-mail sent by Endress+Hauser on delivery of
the product.

1. Start the software.
 The Software activation window is displayed:
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2. Click the Activate button.
 The Software license management window for entering the software

ID is displayed.

3. Enter the software ID.
 A symbol confirms the correct software ID has been entered.

4. Click the Continue button.

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5. If you already have a user account for the Endress+Hauser software portal:
enter the e-mail address and password and click Activate.
 The following window appears if the software has been activated

successfully:

6. If you do not yet have a user account for the Endress+Hauser software
portal, return to step 4 and click the Create account button.

After activation, you can view the license information:
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1. Click the Close button.


The window displays all the relevant information for the license, such
as the serial number, licensee etc.

2. Click the X ( ) in the top right-hand corner to close the window.
 After a moment, the FieldCare program starts.

Software license configuration
The Search for remote licenses checkbox can be enabled or disabled. The
option is given for performance reasons. If the checkbox is enabled, the
computer searches for valid software licenses in the network that are offered
by a license server. If the checkbox is disabled, a valid software license must
be installed locally on the computer. The option prevents the computer from
scanning for licenses in the network.

If necessary, the Software license management function can be opened via
the FieldCare menu Help and License information.
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Activating the software permanently without Internet connectivity
If the computer does not have Internet access, the license can also be activated
manually.

Prerequisites:
• A portable storage device, e.g. a USB stick
• A second computer with Internet access

Overview of the manual activation process

Computer with FieldCare, but
no Internet access

USB
stick

Computer with Internet access

"Software activation - Manual"
window

In the Endress+Hauser software
portal

Step 1

Action: Save license request file
(*.EHR) on USB stick.

=> 1. Activation request

Action: Upload license request file
(*.EHR) from USB stick.

2. License activation/update

Step 2 <= Action: Save license update file
(*.EHU) on USB stick.

Action: Import license update file
(*.EHU) from USB stick.

Step 3

Action: Save license confirmation
file (*.EHC) on USB stick.

=> 3. Confirmation of license
activation

Action: Upload license confirmation
file (*.EHC) from USB stick.
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Detailed description
1. Carry out steps 1 to 4 as described in the section Activating the software

permanently with Internet connectivity.
 The Software activation window is displayed with the message Your

client/server is not connected with the Internet.

2. Click the Manual activation button.
 The Software activation – manual window is displayed.
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3. Click the Save button under Step 1.
 The Windows dialog Save as... opens.

4. Save the license request file (*.EHR) on a USB stick.

5. Take the USB stick to a computer with Internet access.

6. On this computer with Internet access, go to the Endress+Hauser software
portal: https://software-products.endress.com

7. Log onto the Endress+Hauser software portal.

8. Select the Activation/update menu.
 The following view is displayed:

9. Under 1. Activation request, click the Upload button.

10. Upload the license request file (*.EHR) from the USB stick.
 If the upload was successful, the following message is displayed: The

activation request file has been successfully processed. Continue with
step 2 in the Software activation – manual window.
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11. Select OK to confirm the message.
 The name of the activation file "*.EHU" is displayed:

12. Click the Save button.

13. Save the license update file (*.EHU) on the USB stick.

14. Take the USB stick to the computer where FieldCare is installed (no Internet
connection). Make sure you do not log out of the Endress+Hauser software
portal. On the computer without an Internet connection, the Software
activation - manual window continues to be displayed.

15. Under Step 2 click the Import button.

16. Upload the previously saved license update file (*.EHU) from the USB stick.

17. Click the Save button under Step 3.
 The Windows dialog Save as... opens.

18. Save the license confirmation file (*.EHC) on the USB stick.

19. Click the X ( ) in the top right-hand corner to close the window.
 After a moment, the FieldCare program starts.

20. Take the USB stick to the computer with Internet access. You are still actively
logged into the Endress+Hauser software portal.
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21. Scroll down to 3. Confirmation of the license activation.


22. Click the Upload button.

23. Upload the saved license confirmation file (*.EHC) from the USB stick.
 If the upload was successful, the following message is displayed: The

activation of the product has been confirmed successfully.
24. Select OK to confirm the message.

FieldCare is now permanently activated. The license status and license details can
be checked on the Endress+Hauser software portal under Products.

Updating the software license
Prerequisites:
• The software is installed on the computer
• The software is licensed
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1. Open the Software license management function via the FieldCare menu
Help -> License information.
 The following window is displayed:

2. Click the Renew license button.
 The Login to software portal window is displayed.
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3. Enter your e-mail address and password, then click Renew license.
 The following window appears if the software has been activated

successfully:

4. If you do not yet have a user account for the Endress+Hauser software
portal, first click the Create account button in Step 2.

Returning the software license
Prerequisites:
• The software is installed on the computer
• The software is licensed
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1. Open the Software license management function via the FieldCare menu
Help and License information.
 The following window is displayed:

2. Click the Return license button.
 The Login to software portal window is displayed.

3. Enter your e-mail address and password, then click Return license.
 If the software was returned successfully, the Return license window

appears with the message: The software has been successfully
returned.
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4  Installation
Some components take a long time to install. To avoid problems, do not
cancel the installation unless requested to do so.

4.1  System requirements
Install the required software, e.g. Microsoft.NET 3.5/4.x and PDF reader prior
to installation.

In the database mode, FieldCare versions up to 2.10.xx use SQL Server 2008 for
data archiving. FieldCare versions from 2.11.xx are compatible with Windows 10,
provided that the database is updated at least to SQL Server 2014. As of version
2.18, Microsoft SQL Server 2022 Express is installed each time FieldCare is
installed.

A new installation of FieldCare 2.20 is recommended for the Windows 11
operating system. FieldCare 2.20 automatically installs a Microsoft SQL Server
2022 Express, which is required for Windows 11.

Installation and update scenarios supported by version 2.20.xx:

Installed
operating
system

Installed SQL Server FieldCare
database  1)

FieldCare Procedure

Windows 10 No SQL Server
installed

No database
installed

Not installed • Install FieldCare
2.20.xx incl. SQL
Server 2022

• The FieldCare
database is
installed

Windows 10 SQL Server 2014
SQL Server 2016
SQL Server 2019
or
SQL Server 2022

No database
installed

Not installed • Install FieldCare
2.20.xx

• Use existing SQL
Server

• The FieldCare
database is
installed
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Installed
operating
system

Installed SQL Server FieldCare
database  1)

FieldCare Procedure

Windows 10 SQL Server 2014 Database
installed

Not installed
or older
version

• Install FieldCare
2.20.xx

• Use existing SQL
Server

• The existing
FieldCare
database is used

Windows 11 No SQL Server
installed

No database
installed

Not installed • Install FieldCare
2.20.xx incl. SQL
Server 2022

• The FieldCare
database is
installed

1) The SQL Server contains a database that can be used by FieldCare for data archiving.

The FieldCare setup does not support an installation that involves upgrading
the Windows version.

4.2  Software installation
1. Insert the FieldCare USB stick into a USB port and use the Windows file

manager to switch to the root directory.
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2. Start the FieldCare installation program (InstallationManager.exe).


Options on the Installation Manager start page:
• FieldCare SFE500 installation →   19
• DeviceCare SFE100 installation →   22
• DTM library installation →   23
• FDI Package library installation →   26
• More →   26

4.2.1  Installing FieldCare SFE500
1. Click FieldCare SFE500 on the Installation Manager start page.

 The "EULA" tab opens.
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2. Select I agree to accept the license agreement and click Next.
 The "Path" tab opens.
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3. Select the installation path and click Next.
 The "Install" tab opens and FieldCare is installed.

Following installation, the "Report" tab opens.

4. Close the dialog box.

The database password must be changed following successful installation of
FieldCare. The database's standard password cannot be used.



22 Endress+Hauser

4.2.2  Installing DeviceCare SFE100
1. On the Installation Manager start page, click DeviceCare SFE100.

 The "EULA" tab opens.

2. Select I agree to accept the license agreement and click Next.
 The "Path" tab opens.
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3. Select the installation path and click Next.
 The "Install" tab opens and DeviceCare starts to install.

Following installation, the "Report" tab opens.

4. Close the dialog box.

4.2.3  DTM library
To be able to access the devices, the required DTMs and DTM libraries must
be selected and installed.
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1. Click DTM library on the Installation Manager start page.
 The "Welcome" tab opens.

2. Accept the license conditions and click Next.
 The "System" tab opens.
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3. Click Next.
 The "Selection" tab opens.

4. Select the products that need to be installed and click Next.
 The "Overview" tab opens.
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5. Click Install.
 The DTM library starts to install and displays a message to confirm that

installation was successful.

6. Click Close.
 The start page of the Installation Manager opens.

4.2.4  FDI Package library
In order to access the devices with FDI Packages as device drivers, you must
first install the necessary FDI Packages or FDI Package libraries.

1. Click FDI Package library on the Installation Manager start page.

2. Follow the instructions on installation.

4.2.5  More
‣ Click More on the Installation Manager start page.

 The dialog box with the selection options opens.
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DTM library
‣ Click DTM library.

 All available DTMs are displayed.

Communication/Gateway DTMs
‣ Click Communication/Gateway DTMs.

 All available communication/gateway DTMs are displayed.
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Documentation
‣ Click Documentation.

 All documents are displayed as PDFs.

Drivers
‣ Click Drivers.

 All available drivers are displayed.



Endress+Hauser 29

Tools
‣ Click Tools.

 All available tools are displayed.

4.3  Updating the software
Endress+Hauser offers an update contract for FieldCare.

Contact your Endress+Hauser sales partner for further information.

Software update service
The inclusive maintenance period starts with the creation of the license and
ends automatically after one year (expiry date). Regardless of when the
software update service is purchased, any additional software update service
purchased will continue without interruption from the last expiry date. If
purchased after the expiry date, the new maintenance period will first cover
the gap in service created between the expiry date and the creation of the
purchased software update service.

It should also be noted that software updates can also be activated at a later
point in time, provided that the software release was issued within a valid,
active maintenance period.

Subscribing to product information
1. Enter https://software-products.endress.com in the web browser.

2. Log onto the Software Portal.
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3. In the Software Portal, click My account.
 The "My account" dialog box opens.

4. Scroll down, select I agree to receiving marketing communication
information like available updates from Endress+Hauser and click Save.
 You have subscribed to product information.

4.4  Updating the device catalog
The FieldCare device catalog must be updated following the installation of
new DTMs or FDI Packages.

Prerequisites:
• FieldCare has been installed
• The software ID has been entered and the software has been activated
• The DTMs or FDI Packages have been installed

1. In FieldCare, click Device catalog and Update.
 The "Update device catalog" dialog box opens. The window on the left

shows the DTMs or FDI Packages that are not included in the device
catalog. The window on the right shows the DTMs or FDI Packages that
are in the device catalog.

2. Click Update.
 The installed device drivers are updated.

3. Using the right mouse button, click the left window and select Add all to
DTM catalog.
 The DTMs, iDTMs and FDI Packages are added to the device catalog.

4. Click OK.
 The changes are accepted and the dialog box closes.
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